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Experiment HP-1: The Electroencephalogram (EEG)

Background

The living brain produces a continuous output of small electrical signals, often referred to as brain 

waves. The recording of these signals, called an electroencephalogram (EEG), is the summation of all 

the postsynaptic potentials (EPSPs and IPSPs) of the neurons in the cerebral cortex. The amplitudes of 

these signals are so small that they are measured in microvolts which are millionths of a volt or 

thousandths of a millivolt. Though they are small, the signals can be accurately detected and recorded. 

The electrodes that pick up these signals are attached to the surface of the scalp. The signals are then 

amplified many thousands of times. The amplified signals are then recorded with an 

electroencephalograph, which is a device for recording brain waves. The iWorx data recording unit will 

function as both an amplifier and an electroencephalograph for the experiments in this chapter. 

EEG Parameters

The electroencephalograph is a continuous recording of waves of varying frequency and amplitude. 

The number of wave cycles or peaks that occurs in a EEG pattern in a set period of time is its 

frequency. One EEG wave cycle occurring in a second of time is known as a Hertz (Hz). The amplitude 

of the EEG pattern is the strength of the pattern in terms of microvolts of electrical energy. There are 

four basic EEG frequency patterns as follows: Beta (14-30 Hz), Alpha (8-13 Hz), Theta (4-7 Hz), and 

Delta (1-3 Hz). In general, the amplitude of the EEG increases as the frequency decreases.

Cortical Arousal

Each of the four EEG frequencies is associated with a different level of arousal of the cerebral cortex. 

Cortical arousal refers to the firing patterns of the neurons of the cerebral cortex. As the frequency of 

the EEG pattern gets lower, the level of cortical arousal diminishes. As the level of arousal diminishes, 

the EEG pattern gets higher in amplitude. Thus, frequency and amplitude are inversely related in the 

EEG. An EEG with a large amplitude and a low frequency indicates a more synchronized brain wave 

pattern (groups of cells are acting in concert), whereas an EEG with a low amplitude and a high 

frequency generally corresponds with a desynchronized brain wave pattern (groups of cells are 

involved in separate activities). The level of cortical arousal is correlated with various psychological 

and behavioral states.

Behavioral and Psychological States

Some of the behaviors or psychological states often associated with the four prominent EEG 

frequencies are shown in  Table HP-1-B1.
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Table HP-1-B1:EEG Patterns and Behavioral States

EEG 

Pattern
Behavioral/Psychological State

Alpha
Awake, non-focused, relaxed, drowsy, or non-vigilant; low level of environmental 

stimulation (e.g. eyes closed).

Beta
Awake, alert, focused attention and problem solving; dream/REM sleep; high level of 

environmental stimulation (e.g. eyes open).

Theta Visual imagery, hypnagogic/hypnapopic imagery; light sleep.

Delta Deep, restful sleep; vague dream states.

Alpha and Beta EEG

Most EEG records are a complex mixture of EEG patterns. It takes a computer to analyze the 

frequencies represented. The four EEG wave types shown on Figure HP-1-B1 are the result of this type 

of computer analysis. A filter for the specific range of frequencies in each type of EEG wave was 

applied to the raw EEG wave. As a result of the filtering, each EEG wave type within the raw EEG 

signal can be displayed on a separate channel. 

Figure HP-1-B1: Alpha, Beta, Theta, and Delta EEG patterns extracted from an EEG signal recorded 

from the left hemisphere.
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The data displayed on Figure HP-1-B1 demonstrates that Alpha EEG waves were prominent when the 

subject's eyes were closed and she was not concentrating on anything in particular. When the subject 

opened her eyes, the amplitude of her Alpha EEG waves decreased dramatically and the amplitude of 

her Beta EEG waves increased slightly. If the subject had been performing a mental task while her eyes 

were open, the amplitude of her Beta EEG waves would be higher.

A condition known as Alpha Block can occur even when the subject’s eyes are closed. If a subject’s 

attention can be drawn quickly to the events taking place in his or her environment or if the subject is 

performing a mental task or focus, the Alpha wave pattern will disappear and the Beta pattern will 

appear. Alpha Block indicates the existence of a higher level of cortical arousal in the subject even 

though the subject’s eyes might be closed.

In this laboratory experiment, subjects will perform tasks that will allow observers to discriminate 

between the two EEG wave types, Alpha and Beta, which are present in EEG records of subjects that 

are awake. It is possible to observe Theta waves from an awake subject, if he or she is performing a 

successful exercise in visual imagery. However, Delta waves should not be found in your subject’s 

recording unless he or she falls asleep during the experiment.

Personality

Individual differences in personality have sometimes been studied with EEG techniques. In 1967, Hans 

Eysenck theorized that personality can be characterized along a continuum of introversion-

extraversion. According to Eysenck (Eysenck, 1967) introverts and extraverts differ in their thresholds 

for cortical arousal, with introverts having a lower threshold for arousal compared to extraverts. This 

theoretical framework generates the idea that introverts are chronically “overaroused” and thus seek a 

state of lower arousal while extraverts are chronically “underaroused” and thus seek a state of higher 

arousal. Behaviors which differ among the personality types are seen as generated by a characteristic 

physiological threshold for arousal. Researchers have tested this hypothesis and some, but not all, have 

found support for it in the EEG data. References are listed at the end of this experiment if you want to 

read more about the data and issues involved in personality and EEG.

Hemisphere Specialization

There is considerable evidence from studies in neuropsychology that the two cerebral hemispheres of 

the brain are specialized for different cognitive (thinking) processes. In general, the left cerebral 

hemisphere is considered to be specialized for language processes and the right cerebral hemisphere for 

visuospatial processes. One measure of the activation of a cerebral hemisphere is EEG. If it is 

hypothesized that one hemisphere is more aroused or activated at a task than the other, the difference 

would show up as a difference in the EEG frequencies of the two hemispheres. Some researchers have 

demonstrated that the EEG is lower in frequency and higher in amplitude over the right hemisphere 

when a subject is processing verbal tasks, presumed to be a left hemisphere function. Likewise, the 

EEG is lower in frequency and higher in amplitude over the left hemisphere during a visuospatial task, 

presumed to be a right hemisphere function.
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In this experiment, you will:

• learn to collect EEG signals from the left and right cerebral hemispheres.

• learn to recognize common EEG artifacts caused by movements such as eye blinks, 

facial muscle contractions, and head movement;

• learn to recognize and analyze Alpha and Beta EEG patterns associated with closed and 

open eye conditions;

• observe the Alpha block which occurs when eyes are closed and the mind is focused on 

problem solving;

• test an experimental hypothesis about relative levels of Alpha and Beta EEG waves in 

each hemisphere in two psychological states; and

• test an experimental hypothesis about personality and EEG.
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Experiment HP-1: The Electroencephalogram (EEG)

.

Equipment Required

PC or Mac Computer

iWorx unit 

USB cable and power supply

C-ISO-B3G cable and EEG leads

EEG Electrodes

Elastic headband

Alcohol swabs

IXTA Setup

1. Place the IXTA on the bench, close to the computer.

2. Check Figure T-1-1 in the Tutorial Chapter for the location of the USB port and the power 

socket on the IXTA.

3. Check Figure T-1-2 in the Tutorial Chapter for a picture of the IXTA power supply.

4. Use the USB cable to connect the computer to the USB port on the rear panel of the IXTA. 

5. Plug the power supply for the IXTA into the electrical outlet. Insert the plug on the end of the 

power supply cable into the labeled socket on the rear of the IXTA. Use the power switch to 

turn on the unit. Confirm that the red power light is on.

Start the Software

1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is 

not available, click on the Windows Start menu, move the cursor to All Programs and then to 

the listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window 

will appear as the program opens.

2. On the Main window, pull down the Settings menu and select Load Group.

3. Locate the folder that contains the settings group, IPLMv4Complete.iwxgrp. Select this group 

and click Open.

4. Pull down the Settings menu again. Select the EEG-CorticalArousal-LS2 settings file from 

Human Psychophysiology.

5. After a short time, LabScribe will appear on the computer screen as configured by the EEG-

CorticalArousal-LS2 settings.

6. For your information, the settings used to configure the LabScribe software and the IXTA unit 

for this experiment are programmed on the Preferences Dialog window which can be viewed by 
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selecting Preferences from the Edit menu on the LabScribe Main window.

7. Once the settings file has been loaded, click the Experiment button on the toolbar to open any 

of the following documents:

• Appendix

• Background

• Labs

• Setup (opens automatically)

EEG Cable Setup

1. Locate the C-ISO-B3G-504 EEG cable and electrode lead wires (Figure HP-1-S1) in the iWorx 

kit.

Figure HP-1-S1: The C-ISO-B3G-504 EEG cable with five snap leads for use with disposable 

electrodes attached.

2. Insert the connector on the end of the EEG cable into the iWire 1 input on the front of the IXTA 

(Figure HP-1-S2). 

3. Select one person from your group to be the subject in this experiment.

4. Use alcohol swabs to clean the skin where the electrodes will be placed. Five electrodes will be 

placed on the head:

• one is high on the forehead, to the left or right of the centerline.

• one about two inches above each ear, on the left and right temporal lobes.

• one on each parietal-occipital area, two inches to the left and to the right of the midline.
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Figure HP-1-S2: The C-ISO-B3G-504 EEG cable connected to an IXTA.

5. If reusable silver/silver chloride EEG buttons are used as the recording electrodes:

• Place an elastic headband around the subject’s head to hold the electrodes in place. The 

headband should be placed as high over the ear as possible. The headband should be 

tight enough so that it does not slide up or down, but not so tight that it is uncomfortable.

• Place a dab of the tacky conductive gel on each recording electrode before it is placed on 

the proper location.

• Place each recording electrode in the proper location (Figure HP-1-S3).

6. Once the electrodes are in place, attach the five electrode lead wires to the ground and Channels 

1 and 2 inputs on the lead pedestal of the C-ISO-B3G-504 EEG cable. 

• The lead from the electrode over the left temporal lobe is connected to the red or +1 

input.

• The lead from the electrode over the left parietal-occipital area is connected to the black 

or -1 input

• The lead from the electrode over the right temporal lobe is connected to the white or +2 

input

• The lead from the electrode over the right parietal-occipital area is connected to the 

brown or -2 input.

• The lead from the ground electrode on the forehead is connected to the green or C input.

7. If disposable electrodes are used in the recording setup:

• The electrodes need to have as little hair as possible under their centers. 

• Remove the plastic protective covering from the disposable electrodes before applying 

the electrodes to the proper locations.
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• An elastic headband should also be used to hold the electrodes as close to the surface of 

the skin as possible.

• Once the electrodes are in place, attach the color-coded lead wires between the 

electrodes and the inputs on the lead pedestal of the C-ISO-B3G-504 EEG cable in 

accordance to Figure HP-1-S3 and the instructions in Step 6.

8. The lead wire for the ground electrode should not hang down in the person’s eyes. Drape it 

loosely over the top of the subject’s head. This lead can be secured under a headband.

9. Drape the leads for the other electrodes over the subject’s shoulder to the lead pedestal which 

hangs freely down the subject’s back and over the chair. There should be no tension on the 

electrodes.

10. The subject should sit quietly with their hands in their lap.

Figure HP-1-S3: The positions of the electrodes used to record the EEG from a subject.
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Experiment HP-1: The Electroencephalogram (EEG)

Exercise 1: Common EEG Artifacts 

Aim: To learn how to record an EEG and to become familiar with identifying EEG artifacts, especially 

those related to motion in the subject.

Procedure

1. Ask the subject to sit quietly and not move unless told to do so, and to keep his or her eyes open 

during this phase of the experiment. 

2. Click on the Record button, located on the upper right side of the LabScribe Main window 

(Figure HP-1-L1). The signal should begin scrolling across the screen.

Note: If the user clicks the Record button and there is no communication between the iWorx unit and 

computer, an error window will appear in the center of the Main window. Make sure the iWorx unit is 

turned on and connected to the USB port of the computer. Click OK and select the Find Hardware 

function from the LabScribe Tools menu. 

3. Click on the AutoScale buttons at the upper margin of all the channels. Your recording should 

look like Figure HP-1-L1. 

4. Type the <Subject’s Name>-Resting EEG in the Mark box to the right of the Mark button. Press 

the Enter key on the keyboard to attach the comment to the data. Continue recording.

5. Instruct the subject to blink his or her eyes when asked, during the next thirty seconds of the 

recording. Type the letter B for Blink in the Mark box before each time the subject is asked to 

blink. Press the Enter key on the keyboard to mark the recording when each blink occurs. 

6. Instruct the subject to contract his or her facial muscles by frowning or smiling when asked, 

during the next thirty seconds of the recording. Type the letter F for Frown or S for Smile in the 

Mark box before each time the subject is asked to do so. Press the Enter key on the keyboard to 

mark the recording when each frown or smile occurs.

7. Instruct the subject to rotate or tilt his or her head when asked, during the final thirty seconds of 

the recording. Type the letter R for Rotate or T for Tilt in the Mark box before each time the 

subject is asked to do so. Press the Enter key on the keyboard to mark the recording when each 

rotation or tilt occurs.

8. Click Stop to halt recording.

9. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.
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Data Analysis

1. Scroll through the recording using the scroll bar at the bottom of the Main window. Stop at 

marks (vertical lines in the EEG record) where you have entered comments. 

2. Notice that movement of any kind will cause artifacts in the EEG record. Learn to recognize 

these types of motion artifacts and eliminate them from any EEG analysis. Actual variations in 

waking brain activity are potentials with amplitudes that are significantly lower than the 

amplitudes of artifacts.

Exercise 2: Alpha and Beta EEG Patterns 

Aim: To identify Alpha and Beta EEG patterns from a subject with open and closed eyes.

Procedure

1. Instruct the subject that he or she needs to avoid any movement other than opening or closing 

his or her eyes when asked. The subject should have his or her eyes open at the beginning of the 

recording.

2. Click Record, and then click the AutoScale buttons for all six channels. You should observe an 

EEG recording similar to the two topmost traces in Figure HP-1-L1.

3. Type the letter O for Eyes Open in the Mark box to the right of the Mark button. Press the Enter 

key on the keyboard to mark the recording. Record for twenty seconds.

4. While the subject has his or her eyes open, type the letter C for Eyes Closed in the Mark box. 

Press the Enter key on the keyboard to mark the recording as you instruct the subject to close 

his or her eyes. Record the subject’s EEG pattern with his or her eyes closed for twenty 

seconds.

5. Continue to record the subject’s EEG pattern for a total of 2 minutes as the subject alternates 

having his or her eyes open or closed for twenty second periods. Mark the recording with an O 

or a C each time the subject opens or closes his or her eyes.

6. Click Stop to halt recording.

7. Select Save in the File menu.

Data Analysis

1. Scroll through the data recorded in this exercise and find a artifact-free section of data recorded 

while the subject’s eyes were open.

2. Use the Display Time icons in the LabScribe toolbar (Figure HP-1-L2) to adjust the Display 

Time of the Main window to show a ten second artifact-free section of data on the Main 

window. This section of data can also be selected by:

• Placing the cursors on either side of the data recorded while the subject’s eyes were 

open.
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• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

period to the width of the Main window.

Figure HP-1-L1: Recording of EEG from the left and right temporal regions of the brain displayed on 

the Main window. The complete EEG signals are displayed in the two uppermost channels. The Alpha 

and Beta waves derived from the complete EEG signals and the frequencies of those waves from each 

temporal region are displayed on the lower channels

3. Scroll through the data recorded in this exercise and find a artifact-free section of data recorded 

while the subject’s eyes were open.

4. Use the Display Time icons in the LabScribe toolbar (Figure HP-1-L2) to adjust the Display 

Time of the Main window to show a ten second artifact-free section of data on the Main 

window. This section of data can also be selected by:

• Placing the cursors on either side of the data recorded while the subject’s eyes were 

open.

• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the 

period to the width of the Main window.

5. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window (Figure HP-1-L3).

6. Look at the Function Table that is above the uppermost channel displayed in the Analysis 

window. The names of the mathematical function used in the analysis, Max-Min and Mean 

appears in this table. The values for Max-Min and Mean on each channel are seen in the table 

across the top margin of that channel.
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Figure HP-1-L2: The LabScribe toolbar.

6. Once the cursors are placed in the correct positions for determining the difference between the 

maximum and minimum amplitudes and the mean frequency of the waves in a ten-second 

section of data, the values of these parameters can be recorded in the on-line notebook of 

LabScribe by typing their names and values directly into the Journal, and on Table HP-1-L1.

Figure HP-1-L3: Recording of the complete EEG signals, derived Alpha and Beta waves, and the wave 

frequencies displayed in the Analysis window.

7. The functions in the channel pull-down menus of the Analysis window can also be used to enter 

the names and values of the means into the Journal. To use these functions:

• Place the cursors at the locations used to measure the values for the parameters of the 

EEG waves in the selected region of data.
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• Transfer the name of the mathematical function used to determine the values of the 

parameters to the Journal using the Add Title to Journal function in the pull-down menu 

of any channel.

• Transfer the values of the parameters of the EEG waves to the Journal using the Add Ch. 

Data to Journal function in the Left EEG Channel pull-down menu.

8. Use the mouse to click on and drag a cursor to each margin of the data displayed on the 

Analysis window. The values for the following parameters should be recorded:

• The differences between the maximum and minimum wave amplitudes (Max-Min) of 

the waves displayed on the Left Alpha, Left Beta, Right Alpha, and Right Beta Wave 

channels.

• The mean frequency (Mean) of the waves displayed on the Left Alpha, Left Beta, Right 

Alpha, and Right Beta Frequency channels. 

9.  After recording the values found in Step 7 in the Journal and on Table HP-1-L1, return to the 

Main window. Scroll through the recording and find a artifact-free section of data recorded 

while the subject’s eyes were closed.

10. Repeat Steps 2 through 7 on an artifact-free section of data recorded while the subject’s eyes 

were closed. Find the values of the parameters of each type of wave and enter this data into the 

Journal and on Table HP-1-L1 as performed previously.

11. Select Save in the File menu.

Table HP-1-L1: EEG Frequencies & Amplitudes - Different Environmental Stimulation

Max-Min Amplitude (mV) Mean Frequency (Hz)

Eyes Open CH Eyes Closed Eyes Open CH Eyes Closed

Left Alpha Waves 3 4

Left Beta Waves 5 6

Right Alpha Waves 7 8

Right Beta Waves 9 10

Questions

1. Do both hemispheres have a higher level of Alpha wave activity (higher difference in 

maximum-minimum Alpha amplitude and a mean frequency within an 8-13 Hz range) during 

the Eyes Closed or Eyes Open condition?

2. Do both hemispheres have a higher level of Beta wave activity (higher difference in maximum-

minimum Beta amplitude and a mean frequency within an 14-30 Hz range) during the Eyes 

Closed or Eyes Open condition?
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3. Is the Alpha wave level of activity higher in one hemisphere than in the other during the Eyes 

Closed condition? 

4. Is the Beta wave level of activity higher in one hemisphere than in the other during the Eyes 

Open condition?

5. Do these results demonstrate that the subject had an increased state of arousal when his or her 

eyes were open or closed? Give the reasoning.

6. Do these results demonstrate one hemisphere had a higher state of arousal than the other? Give 

the reasoning.

Exercise 3: The Alpha Block 

Aim: To identify the presence of the Alpha Block that occurs when the subject’s eyes are closed and his 

or her mind is focused on problem solving.

Procedure

1. Before beginning this exercise, inform the subject of the experimental conditions:

• The subject should sit quietly with his or her eyes closed throughout the recording 

period.

• Following a quiet period when the subject’s resting EEG pattern is established, the 

subject will be given a mental arithmetic problem to solve.

• The subject should understand that the correct answer is not as important as just working 

on the problem until an answer is found. 

• When the subject has completed the problem, he or she should say the answer out loud, 

and then resume sitting quietly with no particular mental focus. 

• The person operating the computer will enter appropriate comments on the recording to 

indicate the beginning of the quiet period, the time at which the question was asked, the 

time when the subject speaks the answer, and the time when the recording ended. 

2. Type Resting EEG in the Mark box to the right of the Mark button. 

3. Click on the Record button. The signal should begin scrolling across the screen. Press the Enter 

key on the keyboard to attach the comment to the data. 

4. Click on the AutoScale buttons at the upper margin of all the channels. Continue recording 

while the subject is sitting quietly with his or her eyes closed. Obtain a thirty second segment of 

Alpha EEG data that is free or artifacts.

5. Type P1 for Problem 1 in the Mark box. Ask the subject to solve a mental arithmetic problem, 

such as multiplying 46 by 28; or, dividing 157 by 16. The problem should be delivered to the 

subject quickly. Press the Enter key on the keyboard to mark the recording as soon as the 

problem is given to the subject.

6. Quickly, type EP1 for End of Problem 1 in the Mark box. When the subject finishes the problem 

and announces the answer out loud, press the Enter key on the keyboard to mark the end of the 

problem solving period.
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7. Ask the subject to solve another arithmetic problem. Repeat Steps 5 and 6 using a different 

problem labeled as P2.

8. Click Stop to halt recording.

9. Select Save in the File menu.

Data Analysis

1. Scroll through the recording and find the section of data that was recorded while the subject was 

resting with his or her eyes closed, prior to the first arithmetic problem being given to the 

subject. The Alpha EEG wave pattern in this section of data should be similar to pattern 

recorded when the subject’s eyes were closed.

2. Use the Display Time icons to adjust the Display Time of the Main window to show a five to 

ten second artifact-free section of this data on the Main window. This section of data can also be 

selected by using the Zoom between Cursors function.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.

4. The same mathematical functions, Max-Min and Mean, used to analyze the data in Exercise 2 

should appear in the Function Table that is above the uppermost channel displayed in the 

Analysis window. 

5. Use the mouse to click on and drag a cursor to each margin of the data displayed on the 

Analysis window. The values for the following parameters should be recorded:

• The differences between the maximum and minimum wave amplitudes (Max-Min) of 

the waves displayed on the Left Alpha and Right Alpha Wave channels.

• The mean frequency (Mean) of the waves displayed on the Left Alpha and Right Alpha 

Frequency channels.

6. Use one of the techniques described in Exercise 2 to record the names and values of the 

parameters measured in Step 5 to the Journal. Also, record these values in Table HP-1-L2

7. Return to the Main window. Scroll through the recording and locate the section of data recorded 

when the subject was solving the first problem (P1).

8. Repeat Steps 2 through 6 on the section of data collected while the subject was solving the first 

problem (P1). While the subject is solving the first problem, the predominant Alpha EEG 

rhythm should have disappeared. This phenomenon is known as Alpha Block. Enter this data 

into the Journal and in the table.

9. Return to the Main window, scroll to each of the next three sections of data, and repeat Steps 2 

through 6 on the data recorded after the end of first problem (EP1), during the second problem 

(P2), and after the end of second problem (EP2). The Alpha EEG rhythm should have resumed 

after the first problem was solved, disappeared during the solving of the second problem, and 

reappeared after the second problem was solved. Enter this data into the Journal and in thet able 

as done previously.

10. Select Save in the File menu.

Human Psychophysiology - Electroencephalogram (EEG) – Background HP-1-15



Table HP-1-L2: EEG Frequencies & Amplitudes During Low Environmental Stimulation

Subject____________ CH Resting Problem1
Problem

Solved
Problem 2

Problem

Solved

Max-Min Left Alpha Amplitude (mV) 3

Mean Left Alpha Frequency (Hz) 4

Max-Min Right Alpha Amplitude 

(mV)
7

Mean Right Alpha Frequency (Hz) 8

Questions

1. Does either hemisphere have a lower level of Alpha wave activity (lower difference in 

maximum-minimum Alpha amplitude and a mean frequency above the 8-13 Hz range) during 

the problem-solving tasks than during the rest period?

2. Does either hemisphere have a higher level of Alpha wave activity (higher difference in 

maximum-minimum Alpha amplitude and mean frequency within the 8-13 Hz range) during the 

periods after the problems are solved than during the problem-solving tasks?

3. How do the levels of Alpha wave activity in the periods after the problems are completed 

compare to the Alpha wave activity in the rest period?

4. Is the level of Alpha wave activity higher in one hemisphere than in the other during the rest 

period? During the problem-solving tasks? During the periods after the problems are 

completed?

5. Do your results demonstrate the presence of Alpha Block in the subject?

Exercise 4: EEG Pattern in Psychological States

Aim: To test whether a subject’s left hemisphere is more active (alert, aroused), than the right 

hemisphere, when the subject is engaged in language processes. 

And, to test whether a subject’s right hemisphere is more active (alert, aroused) than the left 

hemisphere, when the subject is engaged in spatial processes. 

Evidence for a more active, or more alert, brain is a higher EEG frequency and a lower EEG amplitude 

(faster and shorter in height). Conversely, evidence for a less active, or less alert, brain is a lower EEG 

frequency and a higher EEG amplitude (slower and larger in height).

Procedure

1. There are three experimental conditions in this exercise. During the exercise, you will also need 

to enter comments to indicate:
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• Control Task: Sitting quietly with eyes closed for a minute.

• Spatial Task: Sitting quietly with eyes closed for one minute. During that one minute 

period, the subject should mentally “walk” through his or her house using imagery to 

“see” the rooms and their contents. The subject should not use verbal guidance, nor label 

what is seen, as he or she “walks” from room to room. The subject should imagine each 

room as he or she “walks” slowly through it.

• Language Task: Sitting quietly with eyes closed for one minute. The subject should use 

mental language to “name” each object known to be in his or her kitchen (or any other 

chosen room of the house). Name as many objects as possible in the one minute of time. 

The subject should not visualize or try to picture the objects, just name them.

2. Explain each of the three conditions to the subject. Emphasize that the spatial task should 

involve imagery without language, and that the language task should involve naming without 

visual imagery. All tasks are performed silently with the eyes closed.

3. The control task is the first in the sequence. Flip a coin to determine which of the two 

experimental tasks follows the control task.

4. Type Control Task EEG in the Mark box to the right of the Mark button. 

5. Click on the Record button. The signal should begin scrolling across the screen. Press the Enter 

key on the keyboard to attach the comment to the data. 

6. Click on the AutoScale buttons at the upper margin of all the channels. 

7. Before the end of the one-minute control task, type ECT for End Control Task in the Mark box. 

As you instruct the subject to end the control task, press the Enter key on the keyboard to mark 

the recording. Continue to record.

8. Following the control task, administer one of the two experimental tasks. Remind the subject 

which task to perform and what is supposed to be done in the task.

9. Type LT for Language Task, or ST for Spatial Task, in the Mark box. As you instruct the subject 

to begin the task, press the Enter key on the keyboard to mark the recording. Continue to record 

for one minute.

10. Depending on the task performed, type ELT for End Language Task, or EST for End Spatial 

Task, in the Mark Box. As you instruct the subject to end the task, press the Enter key on the 

keyboard to mark the recording. Continue to record.

11. Administer the other experimental task. Tell the subject which task to perform. Again, remind 

the subject which task to perform and what is supposed to be done in the task. Repeat Steps 9 

and 10 on the second experimental task.

12. Click Stop to halt recording.

13. Select Save in the File menu.

Data Analysis

1. Scroll through the recording and find the section of data that was recorded while the subject was 

performing the control task.
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2. Use the Display Time icons to adjust the Display Time of the Main window to show a ten 

second artifact-free section of this data on the Main window. This section of data can also be 

selected by using the Zoom between Cursors function.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.

4. The same mathematical functions, Max-Min and Mean, used to analyze the data in Exercises 2 

and 3 should appear in the Function Table that is above the uppermost channel displayed in the 

Analysis window. 

5. Use the mouse to click on and drag a cursor to each margin of the data displayed on the 

Analysis window. The values for the following parameters should be recorded:

• The differences between the maximum and minimum wave amplitudes (Max-Min) of 

the waves displayed on the Left Alpha, Left Beta, Right Alpha, and Right Beta Wave 

channels. 

• The mean frequency (Mean) of the waves displayed on the Left Alpha, Left Beta, Right 

Alpha, and Right Beta Wave channels.

6. Use one of the techniques described in Exercise 2 to record the names and values of the 

parameters measured in Step 5 to the Journal. Also, record these values in Table HP-1-L3.

7. Return to the Main window. Scroll through the recording and locate the section of data recorded 

when the subject was the first experimental task.

8. Repeat Steps 2 through 6 on the section of data collected while the subject was performing the 

first experimental task. Enter this data into the Journal and the table as done previously.

9. Return to the Main window. Scroll through the recording and locate the section of data recorded 

when the subject was the second experimental task.

10. Repeat Steps 2 through 6 on the section of data collected while the subject was performing the 

second experimental task. Enter this data into the Journal and the table as done previously.

11. Select Save in the File menu.

Questions

1. Does one hemisphere have more Beta wave activity than the other during the language task? 

Does one hemisphere have more Alpha wave activity than the other during the same task?

2. Does one hemisphere have more Beta wave activity than the other during the spatial task? Does 

one hemisphere have more Alpha wave activity than the other during the same task?

3. Does the subject have more Alpha or Beta EEG activity during either of the experimental tasks 

than during the control task?

4. Do these results support the hypothesis put forth at the beginning of this exercise?
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Table HP-1-L3: EEG frequencies & Amplitudes - Different Psychological States.

CH Control Task Language Task Spatial Task

Max-Min Left Alpha Amplitude (mV) 3

Mean Left Alpha Frequency (Hz) 4

Max-Min Left Beta Amplitude (mV) 5

Mean Left Beta Frequency (Hz)) 6

Max-Min Right Alpha Amplitude (mV) 7

Mean Right Alpha Frequency (Hz) 8

Max-Min Right Beta Amplitude (mV) 9

Mean Right Beta Frequency (Hz)) 10

Exercise 5: EEG and Personality

Aim: To test Eysenck’s hypothesis that during baseline conditions, introverts will show greater cortical 

arousal compared to extraverts.

The hypothesis predicts that subjects scored as introverts should have a baseline EEG with higher 

frequencies and lower amplitudes than the EEG from subjects scored as extraverts.

Procedure

1. Each person in your group and the class will have the opportunity to serve as a subject for this 

exercise. 

2. While recordings are being made, the subject should sit quietly with no particular mental focus. 

Others in the room should also be quiet. 

3. Type the <Subject’s Name>-Eyes Open in the Mark box to the right of the Mark button. 

4. Click Record, and then click the AutoScale buttons for all channels. Press the Enter key on the 

keyboard to attach the comment to the recording. Record the subject’s EEG for one minute 

while his or her eyes are open. Continue to record

5. Type Eyes Closed in the Mark box. Instruct the subject to close his or her eyes and the Enter 

key on the keyboard is pressed to attach the comment to the recording. Record the subject’s 

EEG for one minute while his or her eyes are closed. 

6. Click Stop to halt recording.

7. Select Save As in the File menu, type a name for the file. Choose a destination on the computer 

in which to save the file, like your lab group folder). Designate the file type as *.iwxdata. Click 

on the Save button to save the data file.
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Data Analysis

1. Scroll through the recording and find the section of data that was recorded when the subject’s 

eyes were open.

2. Use the Display Time icons to adjust the Display Time of the Main window to show a ten 

second artifact-free section of this data on the Main window. This section of data can also be 

selected by using the Zoom between Cursors function.

3. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window.

4. The same mathematical functions, Max-Min and Mean, used to analyze the data in Exercises 2, 

3, and 4 should appear in the Function Table that is above the uppermost channel displayed in 

the Analysis window. 

5. Use the mouse to click on and drag a cursor to each margin of the data displayed on the 

Analysis window. The values for the following parameters should be recorded:

• The differences between the maximum and minimum wave amplitudes (Max-Min) of 

the waves displayed on the Left Alpha, Left Beta, Right Alpha, and Right Beta Wave 

channels. 

• The mean frequency (Mean) of the waves displayed on the Left Alpha, Left Beta, Right 

Alpha, and Right Beta Wave channels.

6. Use one of the techniques described in Exercise 2 to record the names and values of the 

parameters measured in Step 5 to the Journal. Also, record these values in Table HP-1-L4.

7. Return to the Main window. Scroll through the recording and locate the section of data recorded 

when the subject’s eyes were closed.

8. Repeat Steps 2 through 6 on the section of data collected while the subject’s eyes were closed. 

Enter this data into the Journal and the table as done previously.

9. Select Save in the File menu.

Personality Rating Scale

1. Read each statement in Table HP-1-L6. Pick the number which best indicates the extent to 

which the statement is characteristic of your personality. Circle the number for each statement.

2. Total the numbers that are circled. The highest score possible is 50, and the lowest score 

possible is 10. Introverts should have low scores; extroverts should have high scores.
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Table HP-1-L4: EEG Frequencies & Amplitudes - Different Environmental Stimulation

Subject________________

CH

Eyes

Personality Score________ Open Closed

Max-Min Left Alpha Amplitude (mV) 3

Mean Left Alpha Frequency (Hz) 4

Max-Min Left Beta Amplitude (mV) 5

Mean Left Beta Frequency (Hz)) 6

Max-Min Right Alpha Amplitude (mV) 7

Mean Right Alpha Frequency (Hz) 8

Max-Min Right Beta Amplitude (mV) 9

Mean Right Beta Frequency (Hz)) 10

Class Data

1. The recordings from each subject should be analyzed using the instructions from Exercise 5. 

2. On his or her own copy of Table HP-1-L3, each subject should enter his or her Identification 

code and personality score. For both experimental conditions, the subject should enter his or 

her:

• Differences between the maximum and minimum wave amplitudes (Max-Min) of the 

waves displayed on the Left Alpha, Left Beta, Right Alpha, and Right Beta Wave 

channels.

• Mean frequency (Mean) of the waves displayed on the Left Alpha, Left Beta, Right 

Alpha, and Right Beta Wave channels.

3. Sort the subjects into two groups based on the personality scores (low vs. high). Use the median 

score of the class as the division between groups. 

4. Calculate the group averages for the differences between the maximum and minimum wave 

amplitudes and the mean frequency of the waves.for each experimental condition in both 

personality groups. Enter these group averages in Table HP-1-L5.

Questions

1. Does the group with lower personality scores (introverts) have a higher level of activity (higher 

mean frequency/lower difference in the maximum-minimum EEG amplitude) than the group 

with higher personality scores (extraverts) during the Eyes Open condition?

Human Psychophysiology - Electroencephalogram (EEG) – Background HP-1-21



2. Does the group with lower personality scores have a higher level of activity than the group with 

higher personality scores during the Eyes Closed condition?

3. Does the group with lower personality scores have a higher level of activity than the group with 

higher personality scores from both hemispheres during both eye conditions?

4. Does the class data support the hypothesis that introverts have a higher level of baseline arousal 

than extraverts?

Table HP-1-L5: Group Averages of Alpha and Beta Activity in Subjects Classified by Personality 

Score

Average of Group with Personality 

Score Below Median

Average of Group with Personality 

Score Above Median

Eyes Open Eyes Closed Eyes Open Eyes Closed

Max-Min Left Alpha 

Amplitude (mV)

Mean Left Alpha 

Frequency (Hz)

Max-Min Left Beta 

Amplitude (mV)

Mean Left Beta 

Frequency (Hz))

Max-Min Right Alpha 

Amplitude (mV)

Mean Right Alpha 

Frequency (Hz)

Max-Min Right Beta 

Amplitude (mV)

Mean Right Beta 

Frequency (Hz))
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Table HP-1-L6:Personality Rating Scale

Rating

1 2 3 4 5

Statement
Very 

Uncharacteristic

Very 

Characteristic

1. I prefer parties with lots of people to ones with 

just a few.
1 2 3 4 5

2. I generally like to study in groups rather than 

alone.
1 2 3 4 5

3. One of the last things I would do when I have 

time off is read a book.
1 2 3 4 5

4. When I go on vacation I prefer exciting places 

with lots of stimulation.
1 2 3 4 5

5. I am often bored when I am home alone and 

there is seemingly nothing to do.
1 2 3 4 5

6. I prefer to have a lot of people I consider as 

close friends.
1 2 3 4 5

7. I consider myself an “action” person; I don’t 

spend a lot of time in deep thought.
1 2 3 4 5

8. My friends see me as outgoing and always 

available for a good time.
1 2 3 4 5

9. I would not like to spend New Year’s Eve

in a quiet place with just a few friends.
1 2 3 4 5

10. For physical activity I like team sports rather 

than individual sports. 
1 2 3 4 5

Score ______________
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